


STAGES™ Technical Support
	� If you encounter difficulties at any stage of your book creation, our technical support staff is available through 

e-mail at techsupport@andersons.com or by phone at 800-650-7742. Our technicians are available to assist you 
in any portion of the yearbook creation process. Technical support is located in the Central Time Zone. 

	

Recommended Hardware:

STAGES Desktop
• 2.0 GHz dual core processor or better*
• 2 GB RAM or more
• Dedicated graphics card
• At least 5 GB available hard drive space
• CD/DVD burner or Flash drive for export
• Broadband Internet access to download updates

* Intel or AMD only. We do not support Power PC Macs.

Although STAGES will run on a variety of computers, we encourage using systems that are similar to the recommended specifications for an optimal experience.

Minimum Hardware:

STAGES Desktop
• 1.0 GHz processor*
• 1 GB RAM
• At least 5 GB available hard drive space
• CD/DVD burner or Flash drive for export

STAGES 13 System Requirements:
PC - Windows XP, Vista or Windows 7     Mac - OSX 10.5 or later AND Java 1.6 or later

STAGES Online
• 1.0 GHz processor*
• 1 GB RAM
• Broadband Internet access

STAGES Online
• 2.0 GHz dual core processor or better*
• 2 GB RAM or more
• Dedicated graphics card
• Broadband Internet access
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The STAGES program enables you to create a book by allowing you to import photos, type text, and place stock or custom 
artwork. The software allows you to do all of this free-form or with the aid of special positioning templates. The instructions in 
this manual will help guide you through the use of the STAGES software.

Table of Contents



2

Installing STAGES on a Mac
Before installing STAGES, please make sure that you have 
full administrative rights to the computer to ensure that the 
installation is successful. It may also be necessary to disable 
anti-virus software if it blocks the installation of new 
programs. If you will be using a school computer to create 
your book, you may wish to contact your IT department to 
confirm or review loading STAGES on the computer. 

You may install STAGES either from the installation CD or 
from our website: yearbooks.andersons.com. 

If you are installing from the CD, place the CD in your drive. 
The STAGES installation CD will appear on your desktop. 
Please double-click on the CD to open it.

Go to the OS X Installer folder and double-click on 
STAGES 13.

This will bring up the Mac installation wizard. Click on 
Continue.

Now you will be at a readme screen. Click on Continue.

This will bring up the STAGES license agreement. Please 
read this and press Continue. If you agree to the terms, 
press Agree.

This will bring up a window where you will choose where 
you wish to install STAGES. STAGES will install by default to 
your Applications folder. You will also have to click on the 
Mac HD at the top of the screen if it is not chosen for you 
by default. If you are unsure of where to install, leave the 
default set and press Continue.

If the installer asks for your password, please enter it. 
This may be necessary to complete the installation. After 
the installation finishes, you will be able to go to your 
Applications folder on the Mac HD to launch STAGES.

When the STAGES program is launched, it automatically 
checks to see if there is an update available. 

If there is an update available, STAGES will automatically 
download and install it. You will receive a notification 
letting you know that STAGES has updated if this happens. 
You will not lose any work that you have done and your 
book will be completely compatible with the updated 
version.

Installing STAGES

Installing STAGES and Java for Windows
Before installing STAGES, please make sure that you have 
full administrative rights to the computer to ensure that 
the installation is successful. It may also be necessary to 
disable anti-virus software if it blocks the installation of new 
programs. If you will be using a school computer to create 
your book, you may wish to contact your IT department to 
confirm or review loading STAGES on the computer. 

You may install STAGES either from the installation CD or 
from our website: yearbooks.andersons.com. If you are 
installing from the CD, place the CD in your drive. On most 
Windows machines, the installer will auto-run. 

If the installer runs by itself, you may skip to the 
installation wizard step.

Open My Computer and go to your CD drive. 

Then go to the Windows Installer folder.

There will be only one file inside the Windows Installer 
folder. This is the STAGES installer. Please double-click on 
that file.

This will bring up the Windows installation wizard. Click on 
Next to continue.

This will bring up the Terms and Conditions. Please read 
them and, if you agree, press I Agree. 

Now you will have to choose a location to install the 
program into. If you are unsure of where to install it, simply 
leave it at the default location shown, and  
press Install.

STAGES will now be installed to your computer. A shortcut 
to STAGES will be placed on your desktop. If you wish to run 
STAGES now, you may press Finish. If you do not wish to 
run STAGES at the present time, uncheck the Run STAGES 
box and then press Finish.

When the STAGES program is launched, it automatically 
checks to see if there is an update available on the Internet. 

If there is an update available, STAGES will automatically 
download and install the update. You will not lose any 
work that you have done and your book will be completely 
compatible with the updated version.
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Copyrights and Your Yearbook
What is a copyright?
Copyright is a form of protection provided by the laws 
of the United States and other countries to authors of 
“original works of authorship,” including literary, dramatic, 
musical, artistic, and certain other creative works. This 
protection allows the creator exclusive rights to these 
works, and to determine who has the “right to copy” these 
works.

Anderson’s Yearbooks reserves the right to refuse to print 
any materials provided by its customers for any reason, 
including, but not limited to, materials determined by  
Anderson’s, at its discretion, to be offensive, illegal, or in 
violation of any copyright or other proprietary rights. By 
submitting an order, and providing photos, trademarks, 
tradenames, images or other content (collectively, the 
“Customer Content”) to  Anderson’s, Customer represents 
that it has the right to have the order printed, with the 
inclusion of the Customer Content, and that printing of 
the order by Anderson’s, and the use of the Customer 
Content, will not infringe the intellectual property right of 
any third party. Customer will defend, indemnify and hold 
harmless  Anderson’s from any claims, costs, losses, and 
liability (including reasonable attorney’s fees and expenses) 
arising out of or related to the Customer Content or the 
production of the Order as directed by the Customer.

How can I find out who owns a copyright?
Some investigative work will be required. If the copyright 
owner is not listed outright on the work you wish to copy, 
you may need to directly contact the publisher of the work 
where you viewed the image to see if they know who the 
copyright owner would be. For web pages, you may need 
to contact the webmaster of the site or the company that 
produced it. For books it is recommended to contact the 
publisher. Anderson’s Yearbooks cannot provide copyright 
advice for you. It is your responsibility to do the necessary 
due diligence and provide us with this information. 

In most cases it is easy to obtain permission from 
companies for logos and images by simply contacting them. 
Most professional clip art packages allow reproduction 
rights for the files you purchase. Other sources such as 
Getty Images (www.gettyimages.com), Landov (www.
landov.com) or other image providers have special rates for 
schools purchasing photos for reproduction in yearbooks. 
You may also search for “Public Domain” images, which 
have limited or no rights restrictions.

You should begin the search immediately if you know 
you have possible copyrighted images. Any delay after 
submission of your yearbook to obtain permission will delay 
the delivery of your books!

Before You Begin

Getting Started
Required computer knowledge
You do not need to know a lot about computers to use 
STAGES. However, you should be familiar with your 
computer, basic word processing programs, and how to 
import and effectively save images. If you plan to scan 
materials, you should be familiar with scanning techniques. 
If you do not use a computer on a regular basis, it is not 
recommended that you use STAGES.

Planning the Book
Please see the Image Requirements section (p.4) of 
this manual. If you have any questions or concerns that your 
images may not meet these requirements, please contact 
Anderson’s Yearbooks for guidance and to perform quality 
testing.

It is recommended that you read over this manual to 
familiarize yourself with the different options and areas 
you might need while laying out your book. Follow the 
instructions in this book to successfully create your book. This 
can be done through the curriculum, your parent/teacher 
organization, or volunteers.

Make a decision on where the book will be worked on, how 
many people will be working on it, and what computers 
you will be using to do the book. Please make sure that any 
computer you will be using meets at least the minimum 
requirements. Plan which topic items you will want on each 
page. Make a list of pictures you will need for each page.

Have your photographer supply you with a high-resolution 
portrait CD or DVD that includes an index file so you can 
import your portrait database. Please note that it is preferable 
to have all portrait pictures on one CD/DVD.

You may start your book before you receive your portrait CD 
or DVD, but you will not be able to flow any portrait pages 
until you receive that CD or DVD. After you receive the CD or 
DVD, you may import your portrait database at any time. 

For the images that you plan to import into your book, it 
is recommended that you place your photos and custom 
artwork (these are images other than your portrait database) 
into folders on your hard drive. It is best if the folders are 
organized by the groups you will be using to sort by in 
STAGES. This will make importing the images much easier.
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*TIP* The previous advice does not apply to digital camera 
images that have been taken at a high quality setting. They 
will have a low resolution, typically 72 DPI, but the image 
size will be large enough to compensate for the resolution. 
This is because the images actually have the extra pixels 
needed to increase the resolution when decreasing the size 
of the photo.

Web Images
Images that are downloaded from the web will generally 
have a low resolution of 72 DPI and will print poorly. 
Additionally, these images are usually copyrighted. It is not 
recommended that you use them in your book.

Digital Images
If you plan to take pictures with a digital camera, you 
should set your camera to take the pictures in the 2-4 
megapixel range. Many digital cameras take pictures that 
are much larger than necessary, and it is advisable to either 
turn your digital camera’s quality settings down or reduce 
their size before importing them into STAGES.

If you have a camera that is over 4 megapixels, you may 
wish to turn down the quality setting on the camera 
so that the pictures that it takes are not exceptionally 
large. Additionally, you should review and select only 
those pictures likely to be used in your yearbook prior 
to importing them. This will help to ensure the best 
performance of your computer while working on the book.

Conventional Photos
If you will be taking photographs with a conventional film 
camera, you can ask your local photo finisher to provide 
you with a High Resolution RGB CD. You will be able to 
import these images directly from the CD into STAGES.

*TIP* For best performance, you may wish to crop or 
otherwise edit these images before importing them into 
STAGES.

Scanning Images
If you choose to scan pictures, the resolution must be set 
to 300 DPI for a scan at 100%. If you plan to enlarge a 
photo after importing, then the resolution of the scan must 
be increased by the same magnitude to compensate for 
the enlargement. For example, a two-inch picture scanned 
at 300 DPI will be two inches when placed on a page. 
However, that same image scanned at 600 DPI would allow 
you to make the image as large as four inches on your page 
because the image would be 300 DPI at four inches.

File Formats
JPEG, TIFF, and PNG are all acceptable file formats. PSD or 
PDF file formats will not be accepted. These formats are 
chosen when you save your images either in scanning or 
image editing software. JPEG files should be saved at high 
quality and are the preferred file format due to their smaller 
size. PNG is typically used for clip art due to the ability to 
set the background of the image to be transparent. You 
should not use PNG for candids.

What do I need to provide to be able to use a 
copyrighted work?
Anderson’s Yearbooks may require a satisfactory letter of 
verification from the copyright owner which grants you 
permission to use their work in your yearbook. In the case 
of purchased clip art or images, simply include a copy of 
your License Agreement, which should specify your rights 
to reproduce the images in your yearbook. Your yearbook 
may be placed “on hold” until all copyright issues have 
been cleared.

Can I quote poems or music lyrics?
Poems and lyrics may also be protected by copyright. It is 
advisable to get the rights from the author or publisher 
before using them.

Image Requirements
All of your digital images will be stored within STAGES after 
you have imported them. As a result of this, you will not 
need to send the actual image files to us when you submit 
your book for publishing. Images may only be imported in 
RGB format. Please read the specifications below and follow 
them closely.

Image Color Mode
STAGES accepts only RGB images. Any other images (such as 
CMYK) will need to be converted to RGB before they will be 
able to be imported.

Image Resolution
Resolution is a very important factor to consider when 
looking at your digital images. Resolution is measured in DPI, 
which stands for dots per inch. Your book will be printed 
with a maximum resolution of 300 DPI. Thus, you will want 
to have the resolution of your pictures above 200 DPI at the 
size they will appear in your book. Going above 300 DPI is 
not necessary and will be unused quality. Because of this, 
your images need to be as close to 300 DPI as possible.

Changing Image Resolution
Many people try to increase the resolution of low resolution 
images in software such as Photoshop®. Unfortunately, 
this usually makes the image quality worse. There is only a 
fixed amount of information in an image, and by increasing 
the resolution and leaving the image size the same, you 
are asking the software to add more pixels to the image. 
The software is then forced to guess what each added 
pixel should look like based on the other pixels around it. A 
common result is that the images will become pixelated or 
fuzzier than they previously were.

If an image did not start out with a high resolution, 200 DPI 
or above, the best way to increase the resolution is to retake 
the picture at a higher camera setting or rescan the image at 
300 DPI. 
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**ONLINE ONLY**

Starting Your Book
In order to activate your STAGES Online book, you will 
need a job number and activation code.  These are emailed 
to you by Anderson’s.  If you do not have a job number and 
activation code, please contact Anderson’s.

Starting A New Book
To begin, go to the File menu and choose Activate.  This 
will open the book activation wizard.  Next, enter your job 
number and activation code, then press Continue.  

If you have an account from a previous year, you can use 
the same username and password for this year.  If you do 
not have an account, you can always create a new account 
for this year.  Choose whether or not you have an account 
from a previous year.  If you do have an account from a 
previous year, enter the information for it.  Once you have 
filled this out, press Continue.

Next, you will have to choose the options for the portrait flow.  

Portrait Font: This is the font that the names will appear in 
on your portrait pages.  you may see a sample of each font 
in our font guide, which is included with the manual.

Portrait Font Size: This is the maximum size that all the 
names will print for the portraits in your book.  Please note 
that names may appear smaller if the name is too large 
when flowed to fit in the given space.  In this case, the font 
size of the names will only be enough o make them fit in 
the space allotted.

Custom Artwork
You may choose to include custom artwork in your book. 
To do so, simply import your custom design as a candid. See 
Importing Images (p.16) for further directions on this. If 
you will be designing an entire page outside of STAGES that 
you wish to bleed (color extending beyond page edge), you 
will need to import it as a custom background. Directions 
for doing this are under Importing Images. You may 
then drag your custom background from the Backgrounds 
tab onto the page. File formats that can be imported are 
JPEG or TIFF. 

Custom Backgrounds
Custom backgrounds may either be backgrounds that you 
have designed yourself or entire collage pages done outside 
of STAGES. If you choose to paste up collage pages to scan 
and import into STAGES, you should avoid textured paper, 
such as construction paper, as well as metallic or fluorescent 
paper or stickers. Color and quality cannot be guaranteed on 
backgrounds that you have created.  

The background should be 300 DPI at 8.5” by 11” when 
created. You will need to leave a 0.625 (5/8)-inch margin on 
all sides to ensure that no important items are trimmed off 
during the binding process. You will then import the file as a 
custom background into your book so that the background 
will bleed to the edge of the paper.
If you do not want your montage to bleed, you may paste 
pictures to the edge of the paper and import as a  
7.5 x 10-inch candid, not a custom background, making sure 
you place it completely within the black line margin on the 
page in STAGES.
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Choose these options and press Continue. 

Next, you can optionally create additional users to log into 
your book.  Additional user accounts allow users other than 
yourself to log into the book and can be created at any time

Creating Additional Users

If you choose to create users, you will see this screen.

Create as many accounts as you see fit and press Continue 
when you are finished.

Next, you will be asked to set up page permissions for any 
users that you had just created.  If you choose not to do this,  
any user that you just created will have editing access to all 
pages by default.  

Setting Page Permissions

If you choose to change page permissions, you will see this 
screen.

Here you can check or uncheck the boxes for the user to 
control how many pages they can access.  Adjust page 
permissions as you see fit and press Continue when you 
are finished.

After this, you will be taken into your book.

Changing Book Properties and 
Controlling User Accounts:
By going to the File menu and choosing Edit Book  
Properties, you can change any option that was set  
during the book activation and you can add or change user 
accounts as well.
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Export Warnings
While you are creating your pages, STAGES Online will 
note if you have placed an item outside the page margin, 
whether you have text that is potentially not visible, or if 
you have images that are beneath 200 DPI. The export 
status of each page will be visible on the page thumbnail.

To check the individual status of each page, place your 
mouse over the page thumbnail and wait a moment.

Also, as you are placing items on your page, if you do 
something that causes an export warning, the edge of the 
item will change color and the export status indicator will 
appear in all four corners. 

 It is highly advisable to correct these errors before you 
finish your book so that there are no problems or delays 
when your book is printed.

Please pay attention to this during the book creation 
process to ensure that no errors occur as you are creating 
your book. The errors may be easy to fix early on, but may 
become harder to fix as time passes.

From here, you can alter book color as well as the portrait 
font options.  If you wish to change the cover options, you 
can click on the Cover Settings area at the top.

If you wish to create additional users or change options 
about existing users, such as their password, you can click 
on the Users area at the top.

If you wish to adjust the page access of user accounts, you 
can click on the User Permission area at the top.

If you wish to see the export status of your book, you can go 
to the Export Info area at the top.
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Master / Single Book Creation With Activation Code:
You will first be asked if you have an activation code.  The 
activation code for your book will repopulate the informa-
tion necessary to create your book from the information 
that you gave to Anderson’s Yearbooks and will only ask 
you for the portrait font and portrait font size.  

Choose the portrait 
font and portrait 
font size, and press 
Continue to create 
your book.

Master / Single Book Creation Without Activation Code:  
If you do not have an activation code, you will be prompted 
to enter the information in manually.  Choose whether or 
not you have an activation code and press Continue.

Next, you will have to either enter in the options for your 
book if you did not have an activation code or confirm that 
they are correct if you did have an activation code.  

Expected Pages: This is the number of initial starting pages 
in your book.  Remember that you may alter that number 
at any time, if you are not sure how many pages your final 
book will be.

Portrait Font: This is the font that the names will appear in 
on your portrait pages.  you may see a sample of each font 
in our font guide, which is included with the manual.

**DESKTOP ONLY**

Starting Your Book

Multiple Users
In order to have multiple people working on the same 
yearbook, it is necessary to create different files for each 
user. However, only one person is allowed to have the 
portrait database and only that person will be able to flow 
portraits. The book with the portraits is considered the 
Master book. This is the book that you will be merging all 
of the other books into. Every other book is a Satellite book. 
These books are used to design candid pages. Books may be 
created using different operating systems (Windows/Mac) 
and still be merged together.

STAGES may be installed on as many computers as you wish.  
Each installation will work separately until the Satellite book 
is finished.  At that point, the Satellite book needs to be 
merged into the Master book.

When creating the Satellite books, you should create them 
with only the number of pages that will actually be completed 
in the Satellite. Satellite books should include no blank pages. 
If your finished book is going to be an 84‑page book, and 
the Master book has 84 pages, do not make a Satellite book 
with 84 pages. When the files are merged together, their 
page count is added together, so you would end up with a 
168‑page book and a lot of blank pages to delete.

If you wish to have an 84 page book when you are finished, 
you would want to set your master and satellite books up 
so that their total pages add up to be 84.  For example, you 
could set your master to have 64 pages and the satellite 
book to have 20 pages, meaning that when they are merged 
together, it would include a total of 84 pages.

Starting A New Book
If you will be using the Master and Satellite feature to allow 
the book to be created on multiple computers simultane-
ously, please see the Multiple Users section for specific 
setup instructions.

To begin creating your book, go to the File menu and 
choose New.  This will begin the Book Creation Wizard.  
Please choose first whether you will be creating a Master / 
Single book, which you would choose if you were the main 
book or if you were doing the book only in this one file, or 
a Satellite book, 
which you would 
only choose if 
this book will 
be merged into 
another book 
after it is fin-
ished.  Once you 
have made your 
choice, press 
Continue.
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Opening Your Book
To open a book that you have already saved, go to File and 
choose Open. Click on the book that you wish to use and 
press the Open button.

Please note that if you try to open a book from a CD, you 
will not be able to make edits to the book. This is because 
CD’s are read-only and do not allow the data on them to 
be edited. If you receive a book on a CD that you need 
to edit, please copy the book to your hard drive before 
opening the book.

Export Warnings
While you are creating your pages, STAGES will note if you 
have placed an item outside the page margin, whether 
you have text that is potentially not visible, or if you have 
images that are beneath 200 DPI.  The export status of 
each page will be visible on the page thumbnail.

To check the individual status of each page, place your 
mouse over the page 
thumbnail and wait a 
moment.

As you are placing items 
on your page, if you do 
something that causes an 
export warning, the edge 
of the item will change 
color and the export status 
indicator will appear in all 
four corners.  

It is highly advisable to correct these errors before you finish 
your book so that there are no problems or delays when 
your book is printed.

Please pay attention to this during the book creation 
process to ensure that no errors occur as you are creating 
your book.  The errors may be easy to fix early on, but may 
become harder to fix as time passes.

Portrait Font Size: This is the maximum size that all the 
names will print for the portraits in your book.  Please note 
that names may appear smaller if the name is too large 
when flowed to fit in the given space.  In this case, the font 
size of the names will be reduced to make them fit in the 
space allotted.

Once you have filled in all of the information, press 
Continue to create your book.

Satellite Book Creation
If you choose to create a satellite book, you will be asked for 
the following information:

Expected Pages: This is the number of initial starting pages 
in your book.  If you are not sure how many pages your final 
book will be, remember that you may alter that number at 
any time.

Once you have filled in 
that information, press 
Continue to create 
your book.

This will create your book, placing the number of pages that 
you specified in the Tab Panel on the left-hand side.

*TIP* All of these items can be changed at a later time 
through either Edit Book Properties under the File menu, or 
by using Insert Page and Delete Page under the Edit menu.  
Please see the appropriate section of this manual for further 
instructions.

Saving Your Book
Before you begin, please save your book.  You can do this by 
going to the File menu and choosing Save.

Now choose a name and location to save your book to 
and then press Save.  The name for your book may be 
anything that you choose, but the name of the file should be 
something that’s easy for you to remember.

*TIP* Name your book something descriptive and save it in 
a location that is easy for you to remember. STAGES will save 
in your home directory by default. For most Windows XP 
users, this will be My Documents.

*TIP* Network drives, portable hard drives, and flash drives 
are great for backing up files and moving them between 
computers. However, as is good practice for any program, 
you should not work directly from them. Your book should 
be saved on your local hard drive whenever it is open and 
being worked on. 
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Finding the CD drive on a Mac
The Mac CD drive is located on the left side of the selection 
window. 

Verify Person Data
After selecting the index file, STAGES will display one 
portrait from your CD and ask you to choose the 
appropriate information for the person displayed. You will 
only need to verify the information on one person. STAGES 
will attempt to determine the correct information, but you 
should make sure that the correct information is in the four 
boxes.

After you have found a person that you recognize, please 
select the correct information from the dropdown menus 
on the right, then press Finish.

Creating Database Manually
If your photographer is not able to supply you with a PSPA-
compliant CD, you can choose to create your own database 
manually. Please note that it is only necessary to do this 
if you are not able to obtain a compatible CD from your 
photographer. To begin, go to the Portraits menu and 
choose Edit Database. STAGES will automatically have a 
blank database for you to fill in manually. 

Use the Add Person button to create each person 
individually. 

When you press 
the Add Person 
button, a blank 
person will be 
created with the 
value of EDIT for 
First Name, Last 
Name, Grade, and 
Teacher/Homeroom.

**ONLINE ONLY**
Importing Portrait Database
It is preferred that you send your portrait CD directly in to be 
imported by Anderson’s Yearbooks. There is a form included 
with your kit that will need to be filled out in order to do 
this. If you have any questions about this process, please 
contact Anderson’s Yearbooks.

Importing Portrait Database
The portrait database is imported from a CD or DVD 
provided to you by your photographer. Your portrait 
database will contain an image for every person that you 
will include in your portrait flows. The portrait database is 
imported through the steps below. Please note that STAGES 
will manage the portraits automatically, you do not have 
to import the portraits as candids, and that all work with 
portraits is done through the Portraits menu.

To import your portraits database, go to Portraits and 
choose Import Database.

Please read the directions and then press Next.

Now you will have to 
select the location of 
your index file. The 
index file is typically 
located in the main 
directory of your CD 
with the folders that 
contain your images, 

or with the images themselves if your CD does not contain 
folders.

Finding the CD drive on Windows
Click the down arrow at the top of the page. 

Choose your CD drive 
from the list. The drive 
may display the name of 
the disc at this time.
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Add Person button. This will add another person to the 
database with EDIT for the first name, last name, grade, 
and teacher. Change the information for this person in the 
same way that you did for the previous person. You will 
have to repeat this for each person you wish to add to the 
portrait database.

In order to save your 
database edits, you will need 
to finish by pressing the 
Apply Changes button 
at the bottom of the Edit 
Database window.

Editing the Portrait Database
You should edit the portrait database as soon as it is 
imported and prior to flowing the portraits to your 
yearbook pages. This will help to ensure that no students 
are accidentally omitted from the portrait flows. However, 
if you do not edit the database immediately, changes may 
be made at any time. 

If you choose to edit the database after portraits are 
flowed, please pay special attention to ensure that 
everyone that is supposed to flow with a class appears on 
the page.

*NOTE FOR ONLINE ONLY* The portrait database can not be 
edited when more than one person is logged into the book. 
This is because editing the portrait database may potentially 
change any page in the book, so no one else can have any of 
the pages locked when the database is being edited.

To edit the portrait database, go to Portraits and choose 
Edit Database.

Through this interface, you may alter any information about 
any of the people that have already been imported into 
your database. This will not include any portraits placed as 
candids. These will have to be altered individually. Portraits 
can be imported into the database after the initial import 
by using the Add Person feature. Please see that section 
of this manual (p.12) for directions.

*TIP* Be careful when changing people from one group 
to another. If you add a person to a group that has already 
been flowed to a page and the portrait flow is already 
full, STAGES will bump the last person off the flow. For 
example, let’s say that you have a group that contains 25 
people and they have been flowed on a page in a five row 
by five column flow, meaning that all people from the 
group are on the page. This particular arrangement leaves 
no spaces to add someone new to the flow. If you were to 
add another person to that group, giving it a total of 26 
people, it would automatically bump the last person from 
the flow off the page.

Change the 
information here to 
reflect the accurate 
information for the 
person you are adding 
to the database.

The final step in the process is to import the portrait for the 
person into your database. To do this, click on the Change 
Picture button.

This will bring up the list 
of all the portraits in the 
database as well as the 
No Portrait options. If you 
do not have any portraits 
imported, it will look like 
this: 

To bring new pictures into 
the database, click on 
the Import Portrait button. This will allow you to select 
portraits that are on your computer and import them into 
your database. Please navigate to where the portraits are 
located, select the portraits you wish to import, and press 
the Import button. 

If you wish, you 
may import multiple 
portraits at once. 
This will allow you 
to simply choose the 
image you wish to use 
in the Image Chooser 
and you will not have 
to go through the 
tedious process of 
locating the images 
one at a time.

Please allow some time for STAGES to go through the 
portraits and bring them in to your book. After STAGES has 
finished, you will see the portrait images appear in the Image 
Chooser. You will be able to choose an image by clicking on 
it. This will place a red box around the edge of the image. To 
set that image to the person you are adding, press the  

Select Portrait button at the bottom of the screen.
You will need to create a new, blank person for every 
person that you wish to include in your book by pressing the 
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the list here, you will no longer see their name appear 
because there will only be one picture. You may alternately 
choose to change their grade/teacher to another value, 
which will give you the option of flowing their portraits at 
a later time.

All People
To see every portrait, not just duplicates, click on the 
Show All People radio button at the bottom. This will 
make the list of names on the right side show all the names 
of everyone in the database.

Add Person
This can be used to insert a person into the database who 
was not present on the portrait CD. To do this, click on 
Add Person. 

This will create a blank person with  First Name, Last Name, 
Teacher, and Grade values of “EDIT”. You will change those 
to reflect the correct information.

*TIP* If you wish to include a person but do not yet have 
a picture of them, you may want to place them in the 
database so that there is a place reserved for them when 
their class is flowed. You can always add their picture at a 
later time using the directions below.

In order to save any changes that you make, you will need 
to press the Apply Changes button at the bottom of 
the screen after you are finished. If you press Cancel or 
otherwise exit the window, your changes will not be saved.

Titles
Titles are optional words that can appear underneath portrait 
names. This can be useful for specifying things like Valedictorian 
or Science. In order to use titles, choose the layout that places 
names underneath the portraits. Note that choosing this option 
allows more space between rows of photos and the photos will 
be slightly smaller.

Delete Person
By deleting a person from your database, you will ensure 
that they are never flowed and they will no longer appear in 
your book. This feature can be used to remove people who 
are no longer at the school or people who have duplicate 
pictures in the database. 

To delete a person, click on the name of the person you wish 
to delete. You will see their picture appear to the right. Click 
on Delete Person and say Yes to the dialog that appears.

*TIP* Be careful when using this as it can’t be undone 
after saving the changes. If you are not sure about keeping 
a person in the database, consider changing the grade 
or teacher to a dummy value such as NOT FLOWED or 
something similar.

Duplicate People
Your photographer may have chosen to provide you with 
multiple pictures for students and left it up to you to decide 
which picture you wish to use. To find out if there are any 
people in your database who have duplicate photos, click 

on the Show 
Duplicate 
People radio 
button at the 
bottom of the 
page.

This will display 
all people who 
have duplicate 
pictures. If you 
choose to delete 
one person from 
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This will bring up the pictures of all the people in your 
portrait database. To import a new picture, click the 
Import Portrait button.

This will bring up the Image Chooser. Navigate to where 
the pictures are located, select the images that you wish to 
import, and press the Import button.

Import more than one picture at a time by holding down 
either shift or ctrl and clicking on the images. You will now 
see their pictures along with all of the other people in the 
database. To select a specific portrait, click on it and press 
Import.

Always be sure to press Apply Changes at the bottom  
of the window to save the changes you have made to  
the database.

*TIP* If you do not have a picture for a person, STAGES 
includes a number of Not Pictured options. Find these at the 
bottom of the Image Chooser after all of the portraits.

People With No Picture
If you click on the Show Only People With No Picture 
radio button, it will pull up a list of all the people in the 
database that do not have a picture attached to them. You 
may either choose from a variety of Not Pictured options 
that have been built into the program or import a picture 
into the database for the student.

Importing Portraits after Initial Import
Begin by either finding a person already in the database who 
does not have a portrait, or adding a new person to the 
database through the Add Person button.

STAGES allows you to import more than one portrait 
database into your book. However, if you have pictures for 
people who are missing from the portrait CD, they can be 
imported into your book one at a time as well. To do this, 
go to a person without a picture and click on the Change 
Picture button. 
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After choosing how you 
want to flow, press Next.  
The next screen will ask 
you which group you 
would like to flow on this 
page.

After choosing which class 
you want to flow onto the 
page, press Next.  This 
will bring up the screen 
where you select staff 
positioning.  Choose the 
options that you want and 
press Next.

On this screen, you will 
choose all of the options 
for the portrait flow itself.  

Flow Portraits Onto:
Single Page: This will only flow portraits across the 
page that you currently have selected. If you do not 
have enough rows and columns for all of the people, the 
remaining people will remain in the portrait flow wizard 
and you will have to flow them on a different page.

Entire Group (Multiple Pages): This will flow all of the 
people from any given class through multiple pages. For 
example, if you have a class of 100 people and you choose 
to flow them with four rows and five columns, STAGES will 
automatically place twenty photos per page and repeat 
that across five pages. However, if you take the same 100 
photos and flow them with six rows and five columns, the 
first three pages will have 30 photos and the fourth page 
will have the remaining 10 photos at the same size as the 
previous portraits.

Group Dimensions
When selecting rows (horizontal) and columns (vertical), be 
sure to leave enough space to include all of the photos that 
you wish to place on the page. For example, if you have a 
class of 26 people, choosing four rows by six columns will 
leave two people off the page. 

Flowing Portraits
After you have imported a database, you may begin adding 
the portraits to the pages by going to the page on which you 
want to add portraits and pressing the Portrait Flow button.

The size of the portraits on the page is determined by the 
number of rows and columns chosen. STAGES will make the 
pictures as large as possible given the number of rows and 
columns. If you want to leave extra space on the page to 
add other items to the page, simply flow with extra rows or 
columns.

For example, if you have a class of twenty and you wish to 
leave extra space on the page, you may choose to flow this 
with six rows and seven columns, which would provide space 
for forty-two portraits. STAGES will automatically place the 
twenty people in the class at the start and leave blank space 
beneath the portraits where you will be able to place clip art, 
candids, and text.

*TIP* Plan where you want each class ahead of time and 
know how much space you have allotted for each class.

*TIP* Be sure to have teachers proofread these pages to 
make sure that everyone is in the correct class, that their 
names are spelled correctly, and that all students in the class 
are pictured.

Even if you have a PSPA CD from your photographer, there 
is still some variation in the way that they are created. Some 
photographers will group teachers with their students and 
some will place the teachers in their own group. If your 
database is not set up as you want it to be, please follow the 
directions below to correct the issue before you flow your 
portraits.

If teachers are with students and you want them on their 
own page, you will have to go to the Portraits menu and 
choose Edit Database and change either the teacher 
or grade (depending on which you chose to group the 
portraits by) to another value. This can be anything that you 
choose, whether it is Staff, Faculty, Teachers, etc. All staff 
should have the same information under either the Grade or 
Teacher field or they will not flow together.

Before going on, please be sure that you are on the page 
that you want to flow portraits to.

To begin flowing portraits, 
either press the Portrait 
Flow button or go to the 
Portraits menu and choose  
Flow Portraits.  You will first 
have to specify whether 
this flow is by Grade, 
Homeroom or Teacher, or 
whether this is a special 
flow of the Teachers, 
Assistants, and Staff.
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After choosing which boxes, if any, you want to remain 
blank, press Finish.

The portrait flow will appear on your page. You can move 
the portrait flow to any location on the page that you wish, 
as long as you stay within the black margin.

*TIP* To make sure that everyone from a given class 
has been flowed onto the page, go back into the portrait 
flow wizard. If the name of the class appears in the 
dropdown menu, then there is at least one person in that 
class who has not been flowed onto the page.

Flowing Teacher Portraits Larger than 
Students’
To do this, you will make two portrait flows. Begin by 
making a new portrait flow, Single Page, one row by one 
column, with teachers at the start, and names appearing 
underneath the portraits. Then press Next, don’t cross out 
any boxes, and press Finish. This will add the teacher to 
the page larger than the students. 

Then flow the student classes normally. You will need to 
cross out boxes within the portrait flow if you wish to have 
the teacher’s picture placed where there would normally be 
student portraits.

Export Warning: Portraits under 200 DPI
If you receive an export warning that your portrait flow is 
under 200 DPI, what has happened is that you have chosen 
to flow the portraits larger than their actual size. You have 
two options: one is to reflow the pictures using more 
rows and columns so that the pictures show up smaller; 
the other is to request a new CD from your photographer 
which has pictures that are at least 640x800 pixels. This 
size will ensure that no matter how large they are flowed, 
they will still be of acceptable quality.

Export Warning: White text must be no 
smaller than 8 point
If you receive this warning, it means that STAGES has had 
to reduce the size of someone’s name under 8 points in 
size and you are using white text. Because of the printing 
process, white text is not allowed to be less than 8 points 
in size. To correct this error, you may either reflow the 
portraits with fewer rows and columns, thus making the 
names larger; edit the portrait’s database and abbreviate 
the person’s name; or use black text.

Organizing Images Through Artwork Groups
All of the objects that can be added to your pages are 
stored within the tab panel on the left-hand side. 

This is the area where you select which items to use on 
your pages. In order to organize images that are imported 
into your book, you have the option of creating new groups 
within each of these areas. To do this, go to the Images 
menu and choose Create Image Group, then choose 

*TIP* If you wish to have all of your class pictures flow the 
same size, regardless of actual class size, you might want to 
locate the largest class in your database and determine the 
number of rows and columns for that class, then flow every 
class with that same number. This will leave empty space 
in smaller classes but will ensure that all class flows have a 
consistent look.

You will need to choose how you want the names to appear, 
underneath the portraits or to the side. You may also choose 
whether you want your portrait name text to be black or 
white.

When you created your book, you specified a portrait font 
size. This size represents the maximum size that portrait 
names can be. Portrait names may be made smaller if it is 
not possible to fit the entire name in at the maximum size. 
Names will be reduced in size as little as possible to fit the 
name in the space allotted. 

If you have a name that is reduced in size and you do not 
wish it to happen, you may either reflow the group with 
fewer rows or columns, reduce the font size by going into 
Edit Book Properties, or abbreviate the person’s name 
through the Edit Database screen.

*TIP* Don’t forget to leave a space for the teacher or assistant 
if you have them flowing with the children. Your teacher will 
flow along with the students if the teacher has the same 
information in the grade/teacher field as the students.

You can see the number of teachers, assistants, and students 
to the right of where you choose the class. Use this as a 
guide to make sure that all of the people from the class will 
be flowed.

*TIP* If you do not see a class in the portrait flow wizard, 
that means that everyone in the class has been placed on a 
page in the book.

*TIP* Remember that you can always delete and reflow 
pictures if you are not happy with the layout. Do not be 
afraid to experiment with different layouts until you find one 
that you wish to keep. To delete a flow, click on it on the 
page so that it puts a green box around the flow, then press 
the Delete key on your keyboard.

The last option to choose is to modify the portrait layout. 
This is done by designating specific locations within the 
portrait flow where portraits will not appear. You do this 
by clicking on the pictures of the people to specify where 
portraits will not appear.

*TIP* If you are flowing with more spaces in the flow than 
the number of people to be flowed, it is not necessary to 
cross out any boxes at the end. STAGES will automatically 
leave unused boxes at the end of the flow blank. Please do 
not check the boxes at the end of a portrait flow simply 
because they do not have a student there yet.
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Please note that this is only for images that you will be 
providing yourself and you will not need to import any of 
the included artwork in this way. See Importing Portrait 
Database (p.10) to import the portrait images provided to 
you by your photographer.

To import images, click on the Import Images button, or 
go to the Images menu and choose Import Images.

First, click on the 
Select button 
to select which 
images you would 
like to import.  
Once you have 
those images 
selected, click on 
Import.

*TIP* You can import more than one image at a time in a 
number of ways. You may hold down the CTRL key when 
clicking on images to select more than one at a time. You 
may also hold down SHIFT to select a range, or press 
CTRL+A to select all items in a folder.

This will display a 
list of the images 
that you have just 
selected.  If these 
are the images you 
wish to bring into 
your book, click on 
Next.

The next screen 
will ask you what 
type of images 
these are.  Choose 
which type of 
image it is and 
press Next.

which type of group you would like to create and provide 
a name for that group.  Please note that images cannot be 
moved between groups after they are imported.

Organization of Images
This section refers to outside images that you will be 
importing yourself such as candids, custom backgrounds, or 
clip art that you are providing yourself. 

Groups serve as an organizational tool so that you can find 
images quickly and easily. Since images cannot be moved 
between groups after they are imported, it is important 
to make sure that you import them into the proper group 
at the start. Any artwork that is bundled into the STAGES 
program will automatically be placed into the appropriate 
group by the program.

To create a group, go to the Images menu, then go to 
Create Image Group. You now choose which type of 
group you want created.

*TIP* You may wish to name your groups the same name as 
the folder on your hard drive that the images will be coming 
from. This will make it as easy as possible to determine 
which images go into which groups. 

You will then be asked to name the group. Please note that 
groups cannot be renamed, so make sure that you name 
it clearly and correctly. Examples of groups would include 
Special Events, Classroom Candids, Field Trips, etc.

Importing Images
This section refers to outside images that you will be 
importing such as candids, custom backgrounds, and clip art 
that you will be providing yourself.

Importing images allows you to add your own pictures, 
backgrounds, covers, and clip art into your book. It is 
important that you identify which type of image you are 
importing before importing them (background, clip art, 
candid, or cover).

**ONLINE ONLY**
The speed at which images import into the program will 
depend heavily on the upload speed of your Internet 
connection. To test the speed of your connection, go to 
www.speakeasy.net/speedtest and perform a free Internet 
connection test.

You may either upload images yourself or send them directly 
to Anderson’s Yearbooks to upload. There is a form in your 
kit that will need to be filled out. Please contact Anderson’s 
Yearbooks for specific details on this.

Also, you can restrict users so that they are not able to 
upload pictures into the book. This is done through the 
Account Administration webpage. Please see that section of 
the manual for directions on how to do this.
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Deleting an Image from Your Book
If you no longer wish to have an image in your book, you 
may right click on the thumbnail of that image on the left 
side of the program and choose Delete.

If the image that you 
are trying to delete is 
still on a page, STAGES 
will warn you that the 
image is already on a 
page. If you go ahead 
with deleting the image, 
it will be removed from 
whatever pages it was 
placed on as well as 
being removed from the 
book.

**ONLINE ONLY**
The ability to delete an image from your book is something 
that you can restrict on a per-user basis. If you do not wish 
to allow a user to do this, you may log in to the account 
administration webpage and turn off this ability for certain 
users. Please see the account administration section of the 
manual (p.6) for further instruction on this.

Designing Your Cover
If you are doing a custom cover within the STAGES 
program, you may choose to use any of our cover 
backgrounds or import your own. The cover backgrounds 
are located in the Cover tab. Creating a custom cover 
may incur an additional cost; please contact your yearbook 
representative for more information.

You add this to the page in the same way that you add a 
page background. Additionally, you design the cover in the 
same way you design any page within your book. If you 
are doing a hard cover or smyth sewn hard cover book of 
80 pages or more, you have the option of placing spine 
text on your book. To do this, place a text box between 
the dotted lines at the center of the cover. 

On a hard cover or smyth sewn hard cover book, STAGES 
marks off where there will be an indentation as a result of 
the binding process.

Please be aware of this as you are creating your cover.

Designing Your Pages

**ONLINE ONLY** User Permissions
The yearbook advisor may restrict users from being able to 
edit pages through the account administration webpage. 
Users may be restricted from editing any or all pages as 
the advisor requires. Please see the account administration 
section of the manual (p.6) for detailed direction on how to 
accomplish this.

Users who are restricted from being able to edit a page will 
not be able to make any changes to the page, but they will 
be able to view the contents of it.

Now you will have to choose the display size of the image.  
Please note that this does not affect the way that your book 
will print in any way. 

If you are importing images that are intended to be under 
a quarter of a page, choose Small, if it will be a half page, 
choose Medium, or a whole page, choose Large.

Please note that 
choosing smaller 
thumbnails will help 
STAGES perform 
faster.  Thus, if you 
are on a lower-
end machine 
or otherwise 
concerned about 
performance, 
choosing Small is 
the best option.

Once you have chosen the display size, press Next.

On the next screen, you will have to choose which image 
group to put the image into.  You can see a list of all of the 
existing image groups in the dropdown menu.  

If you wish to create 
a new image group, 
you can click on the 
button to create a 
new image group, 
into which you 
can import images 
immediately.

To complete the 
import process, 
press Next. 
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Paste
After either cutting or copying an item, go to the page 
where you want to paste the item and then click on the 
Paste icon.

*TIP* You may also use the standard keyboard shortcuts to 
perform Cut, Copy or Paste. To cut, hold down CTRL and 
press X. For copy, hold down CTRL and press C. For paste, 
hold down CTRL and press V.

Undo/Redo
Undo and Redo are both located under the Edit menu. 

Clicking on Undo will undo the last action that you 
performed from whatever page you were working on. 
Please note that there are some actions that cannot be 
undone, such as deleting a portrait database.

Clicking on Redo will undo your last Undo. Use this 
option to cancel out the last Undo.

Zooming
To zoom in or out on the pages, click on one of the three 
Zoom buttons. 

You can use Zoom In and Zoom Out to get a more or 
less detailed view of individual sections of a page. 

Using Zoom to Fit will automatically zoom to the largest 
dimension that allows the entire page to be seen on the 
screen at one time.

Rulers
Ruler guidelines are available both horizontally and vertically 
to assist you in lining up the placement of objects in your 
book. To add a ruler, click anywhere in the ruler area that is 
around the top and left edges of your page.

To remove a ruler, click 
and drag the black arrow 
anywhere outside of the 
ruler itself.

Crop Marks
STAGES shows you an 8.5” by 11” view of your pages with 
a solid black line a half-inch in from the edges of the page. 
Any items that goes over this solid black line may be cut off 
when the book is bound, however it will not necessarily be 
cut off. The book will be cut somewhere between the edge 
of the visible page and the solid black line. If you move an 
item outside of the page margin, you will be given an export 
warning in the bottom left-hand corner of the page.

You may place 
your mouse 
over the 
symbol to see 
a list of the 
export errors 
for the page. 
 

If items fall outside the solid black line on your screen, you 
will need to move them inside of that line to guarantee that 
the item is not cut off when the book is printed.

Cut/Copy/Paste
Cut
To cut an object from your book, begin by clicking on the 
item that you wish to cut. This will put a green box around it. 
Then click on the Cut icon. This will delete the item from the 
page and place it in your clipboard to be pasted elsewhere. 

Copy
To copy an object in your book, begin by clicking on the item 
that you wish to copy. This will put a green box around it. 
Then click on the Copy icon.
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Hand Tool/Adjusting Position In Picture Box
To adjust the positioning of an item within a picture box, 
click on the Hand tool.

This will allow you to drag the item around within the 
picture box, but will keep the outer edges of the picture 
box in place, changing only what is displayed on the screen.

Cropping
To crop an image, click on the image that you wish to crop. 
This will place a green box around the image. Then click on 
the Crop Tool.

This will change the green box to blue. Use the boxes on 
the edge of the image to move the edges of the image 
inward according to how you want the image cropped.  
You can also drag the item around within the crop box to 
change what part of the image is cropped

If you no longer wish to crop images, click on the Arrow 
tool to switch back into normal page editing mode.

Two-Page View
To assist you in getting a more detailed view of what your 
book will look like when printed, STAGES can be set up to 
view your book in Two-Page View. This will show you the 
two pages that will appear side by side when your book is 
printed.

To switch to this view, click on the Two-Page View 
button in the lower right-hand corner of the page. 

To switch back to single page view, simply click the button 
immediately to the left of the Two-Page View button. 
Please note that this view simply has two separate pages 
opened side by side and is NOT a two-page spread. For 
instructions on how to create a two-page spread, please 
see the next section of the manual.

Adding Backgrounds/Borders to a Page
To add a background or border to a page, begin by going to 
the page where you want to add the background or border. 
Then go to the Background tab on the left-hand side.

Choose the series from the dropdown menu at the top 
that contains the background you wish to add. Then drag 
and drop the background you wish to use on the page 
anywhere, in the same way that you would add a candid or 
clip art.

It does not matter where you drop the background as long 
as it is on the page somewhere.

Selecting another background automatically deletes the 
current background.

To remove a background from a page, go to the Edit menu 
and choose Remove Background. Or simply put a 
different background on the page. 

Templates
Templates enable you to quickly and easily create pages that 
have a consistent, professional look. To add a template to a 
page, go to the Templates tab on the left side. 
You then add a template to the page by dragging and 
dropping the template you wish to use onto the page as if it 
were a background.

Templates may be added to pages that are already in 
progress, or to a blank page.  When a template is added to 
a page, STAGES will place a number of picture boxes and 
text boxes to allow you to place your own images and words 
onto the page.

If you do not wish to use some or all of a template, simply 
delete the picture or text boxes from the page.  Items can 
be placed between picture boxes and picture boxes can be 
moved around the page.

Creating Custom Templates
To save an already created page as a template, go to the File 
menu and choose Save Page as Template.

You will then have to choose which group you would like 
to save the template to, just as you have to choose when 
importing an image. 

*TIP* You can create custom template groups just as 
you can for images that you import.
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From here, you may either choose a word from the list to 
replace the word or continue with the misspelled word if 
you are sure that it is actually correct (e.g., if it is a place 
name or proper name).

The red lines informing you that you have a misspelled 
word will only appear when you are in the text box. To see 
if a given text box has words misspelled, you will need to 
double-click on the text box in order to edit it.

Drawing Shapes
To add shapes to your page, go 
to the Shapes and Text tab 
on the left-hand side.

Click and drag the shape from 
its location on the left to where 
you want it on the page. 

To set the color of the shape, 
click on the Fill Color button. 

Then click on the color that you want the shape to be and 
choose Set Color. 

From here, you can move, size, and rotate the shape as you 
see fit. See Item Properties below.

Group Operations
STAGES enables you to do any of the operations you can 
do to a single item to multiple items at once. To select 
multiple items, simply draw a box around the items you 
wish to select.

You may then perform any 
operation on all of the items at 
once rather than having to do each 
item separately.

Two-Page Spreads
A two-page spread enables you 
to design two pages together 
as one large page. Doing a two-
page spread involves linking two 
pages together. To do this, right-
click on one of the pages and 
choose Create Spread.

This will link the two pages 
together and automatically 
make STAGES display both 
pages side by side. From here, 
you can place a single 11x17 
image across both pages, if 
it is imported as a two-page 
background, or you can design a 
collage page as well.

Please note that if you are doing a soft perfect-bound or 
hard cover, there will be a small area in the center, as noted 
by dotted lines, that will be bound into the center of the 
book and may not be visible when printed. Please bear this 
in mind when designing a two-page spread with those 
binding types.

Text Boxes
To place a text box, go to the Shapes and Text tab on 
the left-hand side and drag the icon that says Text onto the 
page and drop it in order to place the text box.

Double-click on the text box in order to change the text.

In order to change the font, font size, text color or alignment 
of the text box, use the Text Color, Font Size, or 
Alignment icons. You do NOT need to highlight text in 
order to change these properties. The properties apply to all 
text in the box automatically. 

Please note that the Font Type is set for the entire text 
box. If you wish to have text in a different font, you will need 
to use a second text box. 

Text Color is available for text 14 points or greater. Text 
less then 14 points will only be available in black or white.

Spell Checking
A spell checker is built in to STAGES and is indicated by a red 
jagged line appearing underneath any words that are not in 
the dictionary.

In order to receive 
suggestions concerning 
how the word should be 
spelled, right-click on the 
underlined word.
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The color of the 
drop shadow is 
adjusted through 
the dropdown. 
Please note that the 
opacity option will 
affect how the color 
appears by making 
it either lighter or 
darker.

The horizontal and 
vertical offsets are 
adjusted in inches 
and may be set up to 
one inch away from 
the object. 

*TIP* To add a drop shadow on the other side of the 
image, use a negative value for horizontal and vertical. For 
example:

Please note that you cannot use Undo to revert changes 
made to drop shadow positioning. If you wish to move the 
drop shadow back to where it was, you will need to go 
back in to the Page Item Properties dialog by right-
clicking on the image, and make the change manually.

Cropping to a Shape
Before starting the crop, you will want to crop out any 
extra space that is on the image to ensure that what you 
want is displayed within the newly cropped image.

To crop an image into a specific shape, click on the image 
so there is a green box around it, and then press the Crop 
Tool in the same way as if you were cropping the image’s 
display area. 

This will turn the border of the image blue to indicate 
clearly which item is being cropped. Then go to the 
Drawing tab on the left-hand side.

Drag and drop the shape you want the picture to be inside 
of the blue outline.  If you no longer wish to crop images, 
click on the Arrow tool to leave Crop.

Item Properties
Within STAGES you are able to manually edit any property 
of an item on your page. To do this, right-click on any 
item that is on your page. This will pull up the Page Item 
Properties Dialog. 

From here, you will be 
able to enter a specific 
value for the X or Y axis 
in inches, which allows 
you to place any item 
at an exact position on 
the page. For example, 
if you have an image 
that you want to place at 

the same spot on a number of pages, you could use this to 
exactly place the image at 1 inch in by 2 inches down. 

You may also specify an image size. Size of the image is 
measured in inches as well. This can be used along with 
Group Operations to make a number of images exactly 
the same size all at once. It may be used individually as well 
to size an image to exact specifications.

It is also possible to rotate images to a specific degree. This is 
useful if you want to rotate an image 90 or 180 degrees. It is 
also useful to combine with Group Operations to make a 
number of images all rotate to the same degree. 

Under the Color tab, you may also add borders to images 
or set the color of a drawing shape.

The Text tab allows you to specify any of the properties of 
a text box. 

Drop Shadow
To add a drop shadow to an image, right-click on the image 
you wish to place a drop shadow on, go to the Drop 
Shadow tab, and choose Enable Shadow.

From here, you will 
be able to adjust the 
fuzziness, opacity, 
color and offset of the 
drop shadow.

Once the drop shadow 
has been enabled, 
you may adjust the 
fuzziness and opacity 
by moving their slider 
bars. 
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Then click on the Line Color button. 

This will bring up a window where you can choose the 
color. Click on the color you want the frame to be and 
press Set Color. 

After you have specified a color, you may change the size 
of the frame around the picture. You do this by choosing a 
different number from the Line Size dropdown box. You 
may also add a frame to an image by right-clicking on the 
image and going to the Color tab. Here you may specify 
Line Color and Line Size. 

*TIP* Note that the frame begins from the edge of the 
image and goes inwards. So if you are also cropping your 
image, be sure to leave space around the edge of the 
image for the frame size that you want.

Nudging
When moving an object, it can be difficult to get it placed 
exactly where you want it using just the mouse. If you need 
to move an object by a small increment, you can use the 
arrow keys on your keyboard to move it slightly in whatever 
direction you wish. This is called Nudging and is useful for 
fine-tuning object placement on your page.

Selecting Items through the Tab Key
If you wish to select an item on your page but cannot 
visually locate it, or if you wish to cycle through all of the 
items on your page, you may do so by pressing the Tab 
key on your keyboard.  Every time you press the Tab key it 
will select the next item on the page, allowing you to go 
through every item.

This will be useful in selecting an item on your page that 
is completely behind some images or has fallen behind a 
portrait flow.

Changing Layout Order
All items that you place on a page are layered one on top of 
another in the order that they are placed on the page. In order 
to change which items appear on top of one another, you will 
need to change their layer order through the use of the 

*TIP* This can also be done in the same manner with 
portrait flows. For example, to crop portraits into and 
oval shape, click on the portrait flow so there is a green 
box around the entire flow. Press the Crop button; the 
Drawing tab; drag and drop the oval shape.

Resizing Objects
To resize an object, 
begin by clicking on 
the item, which will 
place a green box 
around the image. 
Then, click and hold 
on the green squares 
at the edge of the 
image and move your 
mouse to resize the 
image.

Please note that on candids, clip art, squares, diamonds, and 
circles, the proportions will be constrained so that the image 
will not become distorted. Practically speaking, this means 
that you will not be able to increase or decrease the height 
without doing the same to the width, and vice versa. 

*TIP* Pay attention to the resolution of the image if you are 
increasing the size of the image. Reducing the resolution 
of an image too far can lead to poor quality images when 
printed. The resolution of the image is always displayed at 
the bottom of the screen after you click on the image. If an 
image drops below 200 DPI, you will want to either make the 
image smaller on your screen to increase its DPI, or request a 
higher resolution image.

Rotating a Picture
Begin by clicking on 
the picture you wish to 
rotate. This will put a 
green box around the 
picture. Then click and 
hold on the Rotate 
Wheel and move the 
mouse to rotate the 
image. 

If you wish to rotate 
an item by a specific 
degree, you may do 
this by right-clicking 
on the item. This will 
bring up the Page Item 
Properties dialog. From 
here, you may enter a 
specific degree in the 
Rotate box.

Adding a Frame
Begin by clicking on the picture to which you wish to add a 
frame. This will place a green box around the image.  
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may also use the Shift key to select a range of pages to 
delete.

 *TIP* Please be careful which pages you delete because 
deleted pages cannot be restored.

Please remember that this will delete the entire page from 
the book, not just what is on that page.

 *TIP* When you delete a page, STAGES will automatically 
renumber all of the pages. For example, if you delete page 
4, then pages from 5 until the end of the book will have 
their page number decreased by one. Thus, the old page 
5 becomes the new page 4, the old page 6 becomes the 
new page 5, and so forth. Pages 1 through 3 will remain 
the same

Moving a Page
To move a page, click and hold on the page in the Pages 
Panel, drag the page and place it on the page in the 
desired new location. Drop the page you are moving on 
top of another page, not in between. This will simply move 
the page you are dropping it on back one page in the 
book. This will not delete any pages. You may also move 
pages by right-clicking on the page and choosing Move. 
This method requires the pages to be moved to either the 
first page, last page or a specific page.

Pages may be moved in groups. To do this, select more than 
one page by holding down the CTRL key and clicking on the 
pages you wish to move. You may also use the Shift key to 
select a range of pages to move. From there, simply drag 
the pages to the location you would like them to be and 
drop them.

*TIP* If you move a page that has portrait flows with the 
names appearing on the sides of the images, please note that 
the names will always appear opposite the binding edge for 
visibility reasons. Thus, if you move an odd-numbered page 
to an even-numbered page, or vice versa, the names will shift 
from one side of the portraits to the other. On odd-numbered 
pages, the names will always appear to the right of the 
portraits and on even-numbered pages, the names will always 
appear to the left of the portraits.

*TIP* If you wish to see more pages to make it easier to 
move a page from one part of the book to another, you 
may make the area where you view pages bigger or smaller 
simply by clicking and holding on the area between the page 
view and where the selected page is displayed, and dragging 
it in or out.

Snap-to Grid
In order to enable you to quickly line up objects on your 
page, STAGES has an optional Snap-to Grid to assist 
in setting up pages. The Snap-to Grid will force all the 
pictures you place on a page to align themselves to a grid. 
This will enable you to line up images across a page at an 
even level.

To enable the Snap-to Grid, go to the View menu and 
choose Show Snap-to Grid.

To hide the Snap-to Grid, go to the same location, which 
will now read Hide Snap-to Grid.

Move Forward and Move Backward buttons. Take this 
set of images, for example:

If you wish to move 
the selected item 
to the back, you 
would use the Move 
Backwards button. 

By clicking the button 
multiple times, the 
image moves to the 
back of the other 
images that it is 
stacked with.

The Move Forward 
button can be used 
to bring an image 
forward. Please note 
that portrait flows are 
always going to be the 
top layer. Items that 
are placed on top of 
portraits will be sent 
behind the portrait 
flow when the book 
is closed. Also, backgrounds are always the back layer. As a 
result of this, it is not possible to move anything behind the 
backgrounds.

*TIP* Portrait blocks are always the top layer on any given 
page. If an item is moved on top of a portrait, STAGES will 
move the portrait block back on top. 

Page Operations

**ONLINE ONLY**
Performing any of the page operations (adding, moving, 
or deleting a page) requires that no more than one user 
is logged in to the book. This is because these operations 
could potentially change any page at any time, thus, no one 
else may have a lock on a page when someone is attempting 
to add, move, or delete a page.

Adding a Page
To add a page, select the page 
immediately before where you 
want to insert the new page. 
Then go to  the Edit menu 
and choose Insert Page. This 
will place a new, blank page 
immediately after the page 
that you are currently on.

Deleting a Page
To delete a page, go to the page that you wish to delete, 
then go to the Edit menu and choose Delete Page. 
Multiple pages may be deleted at one time. To do this, begin 
by selecting more than one page by holding down the CTRL 
key and clicking on the pages that you wish to delete. You 
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your screen. Additionally, get as many people as possible 
involved in the proofing process. More eyes looking at 
the book means more mistakes get corrected. Have the 
teachers proof the pages that contain their students. They 
are the ones most likely to notice if a child is missing or if 
there is a child who does not belong in their class.

Printing the book is 
also a valuable way 
to show others the 
results of your work. 
To print a hard copy 
of your book, go 
to File and choose 
Print. This will pull 
up a window where 
you will be allowed 
to choose which printer you wish to use, as well as the 
number of copies and the page range to be printed.

Because of the differences between your lab-printed 
photos, your color printed proof, RGB monitors and the 
printing process, you may experience reasonable variation 
in color between your photos, proof, or monitor and 
your final printed yearbook. This variation is normal and 
considered acceptable in the printing industry. 

Hard copies printed from the STAGES program are low-
resolution, and should not be used to determine the 
printability of the images used in your book or for the 
accuracy of the color. The STAGES program warns users if 
the resolution of any image is too low for our standards. If 
the book is submitted containing low-resolution images, 
the publisher will not be held responsible for their quality.

Generating a PDF of Your Book
STAGES can generate a low-res PDF of your book. This file 
is a very accurate representation of what your book will 
look like when it is printed, except that the version that you 
generate will be much lower resolution and watermarked.

 
This can be useful for allowing 
people to review the book 
without having to print the 
book out. The PDF can be 
e-mailed or burned to a disc 
to allow anyone to see what 
the book will look like without 
having to have STAGES installed 
or print a physical copy. To do 
this, go to the File menu and 
choose Print. 

In the dropdown menu 
where you choose your 
printer, there is an option for 
the STAGES PDF Printer. 
Choose this, then the other 
options that you want and 
click Print.

STAGES will then ask you 
where you would like to save 
your book. Choose a location and press Save.

**Desktop ONLY** Merging
To merge books together, open your Master book, go to the 
File menu, and choose Merge.

Then select your Satellite book and press Open. STAGES 
will merge your two books together.  This will append all of 
the pages from your Satellite book to the end of your Master 
book.

*TIP* STAGES will merge everything from your Satellite book 
into your Master book.  This includes both used and unused 
images.  For best performance, before doing the steps 
above, open your Satellite book and go to the File menu 
and choose Delete Unused Images.  Then save and 
close your Satellite book and do the steps above.

*TIP* When you merge two books together, STAGES will 
merge blank pages as well.  If you do not wish to have blank 
pages merge, delete them from the Satellite book before 
merging the books together.

Edit Book Properties
When your book was set up, a number of things such as 
number of pages, page size, portrait font, portrait font size, 
portrait sorting, and whether you are doing a custom cover 
within STAGES were chosen. Understandably, these items can 
and do change during the course of creating your book. If you 
ever need to change any of these, you may do so by going to 
File and choosing Edit Book Properties.

This will bring up a window where you can adjust the portrait 
font, the portrait font size, portrait sorting, and whether you 
are doing a custom cover. 

When changing any properties of your book, you should be 
aware that altering these may change your cost per book and 
may change your book’s delivery date as well. If you have any 
questions about this, please contact your Anderson’s consultant.

**ONLINE ONLY**
Editing the properties of your book requires that no more 
than one person be logged in to the book. This is because the 
changes made there could potentially affect any page in the 
book; thus, no one else can be in the book when the book 
properties are being edited.

*TIP* If you adjust the portrait font or portrait font size, 
please be sure to proof your portraits to verify that you are 
happy with the changes. Changing the font or font size can 
and will adjust the sizing of the names and it is important 
that you review each page to make sure that you have the 
look you are trying to achieve.

Printing, Proofing, 
and Exporting Your Book
Printing Your Book to Review
It is very important that you proof your book carefully before 
submitting it for publishing. Printing your book for review 
places a hard copy of the book in your hands and can be 
very helpful for finding errors that you may have missed on 
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Proofing and Exporting Your Book
Overview of the Export Process
Overview of the Export Process
Exporting a book for publishing consists of printing a hard 
copy of your book to review during the export process, go-
ing through the export wizard and then either uploading 
your book or saving an EZX file to your computer for offline 
submission.  The export wizard will guide you through all the 
necessary steps.  During the process, if you find any errors 
in your book, you may click the Cancel button to exit the 
process and continue editing your book.

If you have to cancel out of the export process for any  
reason, you will need to start it again from the beginning.

The exported copy of your book will have the extension of 
.ezx and is what your book will actually be printed from.  
During the exporting process, you will review a proof of your 
book on the screen.  This proof is to verify placement of 
page items and to allow you to review export warnings.  In 
the event a hard copy is submitted and there is a discrepancy 
between the hard copy and the proof you see on the screen, 
we will consider the proof you see on the screen as the cor-
rect version of the document.  All adjustments to the digital 
file will be considered corrections and charged accordingly.

Book Export
After you have completed your book, please print out a hard 
copy and carefully review it to ensure there are no errors 
or omissions. After corrections are made and your book is 
ready, the next step is to export your book for publishing.  
Exporting your book for publishing will assist you in upload-
ing your book directly for publishing or generating an EZX 
file to be submitted offline. 

Begin by ensuring your finished book has a page count that 
is a multiple of four. Because of the way the book is printed, 
your finished book will have to be in this format. STAGES will 
not allow an export unless it is. After you have verified this, 
please save your book. 

To export your book, go to the File 
menu and choose Export.  This will 
open the export wizard.  STAGES will 
then gather information about your book 
to be used during the export process.  
While this is ongoing, you will see the 
screen below.

Once that process is complete, you will be prompted to 
enter your job number if you did not use an activation code 
to set up your book.  If you used an activation code to set 
up your book, you will not see this screen.  

Your job number is given to you by Anderson’s.  Please 
contact Anderson’s if you are being asked for a job number 
and do not know what it is.  Please enter your job number 
here and press Continue.

Next, you will be presented with your book and cover 
set up information.  Please verify that it is correct.  If the 
information is not correct, you will need to cancel out of 
the export process and correct the information.  Once you 
have determined that it is correct, check the box saying 
“The settings of my book and cover are correct” and press 
Continue.

The next screen will display a list of all people who are in 
your portrait database but have not been flowed onto a 
page.  

If you believe that any of these people should be flowed, 
you will need to cancel out of the export process and verify 
that they are on the page that they are supposed to be on.  
Once you have verified that these people are not supposed 
to be flowed, please check the box that says “I understand 
that the people listed above are not flowed in my book” 
and press Continue.
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Next, you will be presented with an electronic proof of your 
book.  This proof demonstrates any export warnings that 
may be on any pages and also serves as a final check that the 
layout and placement of page items is correct.  Please review 
any export warnings and proof the book a final time.  This is 
your last opportunity to catch any changes that need to be 
made before the book is submitted for publishing.

After approving your proof, you will need to specify your 
method of payment. Choose an option and press Continue.

Once you have checked all of the export warnings and 
looked over all of the pages, check the box that says “I have 
carefully reviewed my book and approve all layouts” to 
signify that the page designs are what you want and check 
the box that says “I approve all low resolution images in my 
book” to signify that you are aware that any images which 
are giving the export warning about being low resolution are 
approved to print as-is.  Once you have checked those two 
boxes, press Continue.

Next, you will need to enter contact information should 
there be any questions about your book submission.  Fill in 
both the first and second contact persons and then press 
Continue.

Next, you will need to enter the information for your 
school.  Please fill this out completely.  Note that the ad-
dress here is not necessarily the address where the books 
will be shipped.  You will be able to enter a different ship-
ping address later if you wish.  When you are finished filling 
this out, press Continue.

Now, you will need to enter in the number of books that 
you are ordering.  Please enter in that number and press 
Continue.

On the next screen, choose whether or not you wish to 
receive a proof and press Continue.

If you choose to receive a proof, you will be prompted to 
enter an address before you can press Continue.
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On the next screen, you will be asked to enter a shipping  
address for your books.  You may choose to ship them to the 
school, whose address you entered on a previous screen or 
your may choose to ship them to a different address.  

If you choose to ship them to a different address, you will be 
prompted to enter the address.

Next, you will be asked whether you want personalization.  
Choose which personalization option you wish and press 
Continue.

On the next screen, you will be asked if you want a year in 
review section into your book.  Choose which options you 
want and press Continue.

Next, you will be given the opportunity to enter any spe-
cial instructions for your book.  These instructions are any 
directions you wish to give about your book submission not 
covered at any point during the export process.  Please enter 
any special instructions you may have and press Continue.  

On the next screen, you will need to agree to the terms and 
conditions and then fill in your name and title.  Once you 
have done that, press Continue.  

The screen that appears next depends on whether you are 
doing an STAGES Online book or an STAGES Desktop book.  
Please see the appropriate section to finish your book export.
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STAGES DESKTOP: 
You may now choose to submit your book online directly 
or you may choose to save the files to your computer to be 
submitted on a CD, 
DVD, or Flash Drive.  
Choose which option 
you want and press 
Continue.

Desktop Offline:
If you choose to submit your book on a CD, DVD, or Flash 
Drive, you will first be asked about whether you want the 
media back.  Choose the 
appropriate option and 
press Continue.

Once you choose this, STAGES will begin creating your 
export file.  This export file will have the extension of .EZX 

and that one file is 
all that you will need 
to submit.  The file 
will be saved in the 
same location as your 
book.  Please place 
this file on a CD, DVD, 
or Flash Drive and 
submit it offline.

Desktop Online: 
If you choose to sub-
mit your book directly 
by uploading it, you 
will see a progress bar 
as your book is being 
uploaded.  

You will be notified when the upload is successful.

STAGES ONLINE EXPORT:
The book submission process is now completed.  You will 
receive this screen to confirm that the submission was 
successful.
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Helpful Tips
Portrait names can be difficult to read on darker 
backgrounds. You might want to consider choosing a border 
or lighter background. You may also try making the portrait 
text white when using a darker background.

When importing candid images, you should select the 
group that they are going to be placed into before starting 
the import. Once the import has begun, you won’t be able 
to change the tab that the photos have been placed into. 
You can move them later, but selecting the right one from 
the start saves time.

Keep all images and text within the black margin lines 
on the computer screen to avoid having items cut off. The 
black margin line around the page is a boundary, and only 
the background should go beyond it.

Do not use copyrighted materials in your book. 
These include product logos, photographs from magazines, 
photos downloaded from the Internet, movie posters/DVD 
covers, CD covers, professional sports logos, etc.

Proof your PDF file before submitting your book. The 
publisher will go by this if there is something in question 
when the book is processed.

Troubleshooting/FAQ
Cover Setup
May we print on the back cover?
Only if you are creating a custom cover. Custom cover pricing 
includes printing on both the back and front covers.

Formatting Your Images
Should my images be in RGB or CMYK color mode?
Only RGB images can be imported into the STAGES program. 
Grayscale images should be converted to RGB as well. 

Which file format should we use to save our images?
STAGES accepts JPEG, TIFF, and PNG files only. JPEG files 
are recommended for candids because of the much smaller 
file size when compared with TIFF files. PNG files are 
recommended for clip art because PNG files can have a 
transparent background.

At what resolution should I have my images?
Every image should be 300 DPI at the actual size the image 
will appear in your book. Scanned pictures should also 
be scanned at 300 DPI at the actual size the image will 
appear in your book. When ordering a photo CD from your 
photographer you should request a high resolution CD.

How do I know if my images are high resolution?
STAGES keeps track of the resolution of every image that has 
been placed on a page. When you click on an image within 
STAGES, the resolution is displayed at the bottom of the 
screen.

Can I open images in Photoshop and change the 
resolution to 300 DPI?
Your images will still be blurry even if you force them into 
a higher resolution. You cannot add quality back in to an 
image where no quality existed previously. 

My image is only 72 DPI but it is very large (40 inches 
by 30 inches); will this image be okay?
Certain digital cameras take images at 72 DPI but make 
them extremely large to retain quality. An image that is 72 
DPI at 40 inches by 30 inches has an actual size of 2880 
pixels by 2160 pixels. This means that this image could be as 
large as 9.6 by 7.2 inches and still be 300 DPI since 2880 / 
300 = 9.6 and 2160 / 300 = 7.2.

How should my images be named?
You can name your images in any way that you see fit. 
STAGES will automatically rename any images that it needs 
to. There is no reason for you to rename your images for 
STAGES.

May we import images from a digital camera? 
Yes. You should have your camera set to between two 
and four megapixels so that images are the appropriate 
resolution.

How will we know if our images are linked correctly?
You will not need to worry about linking images in STAGES. 
The program automatically stores a copy of your image 
within your book when you initially import it.

May we include a two-page spread in our book? How 
should we submit it? What size works best?
Yes, a two-page spread can be done directly through the 
STAGES program. A digital 11 x 17-inch photo at 300 DPI 
provides the best results. A 10 x 8 or 14 x 11-inch photo 
will also work, but will not be proportional to the page size 
and will leave a 1/2-inch margin on the top and bottom 
of each page. When creating your image, be sure to leave 
space in the center for the gutter. To avoid empty space, 
make sure that you have ample space in the picture around 
the subject of your photograph that can be cropped out.

Artwork
Does STAGES include artwork for me to use in my 
book?
Yes, STAGES includes a wide variety of backgrounds, 
borders, clip art, and autograph pages for use in STAGES. 
Use coordinated artwork from one of the artwork series or 
mix and match to suit your tastes. There are no usage limits 
on stock artwork in STAGES.

Can I import my own clip art into STAGES?
Yes, you can import any clip art so long as it is not 
copyright protected and meets our specifications: RGB 
color profile, high resolution, and JPEG, TIFF, or PNG 
file format. PNG files are allowed to have a transparent 
background, so you will be able to see the background on 
the page around the clip art. This makes them ideal for 
use as clip art. Custom clip art should be imported into the 
Clip Art tab and you can either make your own tab or use 
the standard Default tab.
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May we use custom artwork?
You may use custom artwork that follows our guidelines. 
Use caution when bringing in custom art. We cannot 
guarantee that custom art will reproduce through our image 
setters, nor can we assure faithful color reproduction. Not all 
art is suitable for printing processes, and not all art is legally 
available for reproduction if you are selling your books. If you 
choose to use custom art, you can import it from a CD or 
scan it and import it into STAGES as a candid image.

Can I place images to the edge of the page in a 
collage?
It is not recommended to place any images outside the solid 
black line on the screen as these images may be cut off 
when your book is printed. If you are aware that any images 
placed outside the solid black line may be cropped and you 
are okay with these images being potentially cropped, please 
note on the production form that you realize cropping may 
occur. Do not place any text outside the margin lines.

Book Submission
What process do we follow to get our book printed?
Complete the export process as detailed earlier (p.25‑28) in 
the manual. This will provide all of the necessary information 
to the publisher. If you have any questions or concerns about 
whether your yearbook was received properly, please contact 
Anderson’s Yearbooks.

Do we get to see a proof of our book before it’s 
printed?
No. The PDF file you download and review will be used 
as the proof to check the final pages against. You should 
keep a copy for yourself of the digital files you submit for 
publishing. If you discover errors or changes you’d like to 
make after your book has been submitted, please call to see 
what can be done. Changes made after you submit your 
book will incur an additional charge and may delay your 
book. If you request a proof, you will be billed for the proof 
and your book will be delayed. It will be rescheduled to the 
next available date once your proof is returned. To avoid 
delays, please let Anderson’s Yearbooks know if you will be 
requesting a proof when you sign up, so your book can be 
scheduled properly.

When will our book ship?
The STAGES plan is fast. In as few as twenty-four business 
days after you send in your files and they pass preflight, your 
books will be shipped. Allow up to five business days to 
receive your books.

**ONLINE ONLY** 
Problems Getting Started
I started the STAGES application but I don’t see my 
pages. 
After you start STAGES, you will have to open your book. 
To do this, go to the File menu and choose Open. You will 
then be prompted for a username and password. If you do 
not have one, please contact your yearbook advisor. If you 
are the yearbook advisor and have not yet activated your 
account, please follow the instructions earlier in the manual 
on how to do this.

Flowing
The names on my portrait flows are not the way I 
want them (example: Harold instead of Harry, names all 
in upper case, etc.) To fix this, you will have to go to the 
Portraits menu, choose Edit Database, and make the 
changes you wish to make. Any changes that you make 
under the Edit Database screen will automatically be 
reflected on the portrait flows. You will not need to reflow 
the portraits.

I have two classes that are flowing together. How do 
I get them to flow separately? 
To get two classes to flow separately, you will have to go to 
the Portraits menu and choose Edit Database. In this 
box, you will have to change every student in one of the 
groups to be another value. For example, if there are two 
kindergarten classes that are flowing together, you might 
consider changing one class to “Kindergarten AM” and the 
other to “Kindergarten PM.” 

I want to flow my portraits but the icon is not 
highlighted.
First, make sure that you are not working on the cover. If 
you are not on the cover, the problem is that you do not 
have a database imported. If you import a database, you 
will then be able to flow portraits.

Working With Images
How do I delete candids from the book? 
To delete a candid from the book entirely, go to the tab on 
the left-hand side that contains the candid. Right-click on 
the candid and choose Delete.

Is it okay if I use color images on my black and white 
book?
Yes. When your book is submitted, any color images will be 
converted to black and white. Please bear in mind that dark 
backgrounds will show up darker when the book is printed 
in black and white, so you may want to consider using 
lighter backgrounds.

How do I import multiple images at once? 
When selecting images, there are a few keyboard shortcuts 
to know that will allow you to import multiple images. 
First, by holding down the CTRL key, you can click on 
individual images to select them one at a time. By clicking 
on one image, then holding down the SHIFT key, you will 
select all items in the range between that image and the 
next that you click on. Finally, by pressing CTRL+A, you will 
select every item in the folder that you have open.

I was given a picture that isn’t in a format that 
STAGES supports (Microsoft Publisher file, Adobe 
PDF file, etc.). What do I do? 
You should contact the person who gave you the image 
and request a JPEG, PNG or TIFF file. STAGES will not 
import any files other than those.
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I need to select an item that’s completely covered by 
another item (such as a portrait flow). What do I do? 
You can use the tab key on your keyboard to move between 
all the items on a page. If you are unable to select an item, 
simply press the tab key on your keyboard until the item you 
wish to select appears. 

Text
I’m trying to change the color of my text and it won’t 
stay changed to the color I want. 
Because of limitations in the printing process, you will not 
be able to select any color other than black or white, for text 
that is less than fourteen points in size. You may have white 
text as small as eight points in size. If you try to change the 
text color when the size is too small, it will simply revert to 
black.

I’m trying to use a special character, but when I click 
off of the text box, all I get is a square. 
Only certain special characters are compatible with STAGES.  
See the inside back cover for complete list.

I have a document done in a word processing program 
(such as Microsoft Word); how do I get the text into 
STAGES? 
While STAGES cannot directly import text, you can use the 
copy/paste function in order to bring text in. To do this, 
open the file in whatever word processing program it was 
created in, highlight the text and press CTRL+C to copy the 
text. Then go to STAGES and insert a text box. Edit the text 
box so that there is nothing there but a blinking cursor and 
press CTRL+V to paste. You may have to increase the size of 
the text box in order to properly display all of the text. Also, 
any formatting such as size changes or bold/italics will be 
discarded.

Printing
My printer stalls after X number of pages. 
This is caused because your printer is set to spool the entire 
document before printing but then the printer does not have 
enough memory to handle the entire file. This can be solved 
by printing ranges. If your printer prints the first 56 pages of 
an 88 page book, just print 1-55 and then 56-88, or 1-44 
and then 45-88. This will ensure that the printer does not 
run out of memory when printing.

Exporting
I’m getting “items outside the page margin” in the 
Verifying Page Layouts section.
If you get this error, you need to go back through your pages 
on the screen and verify that you can see the solid black line 
around every page that is giving that error. If you can see the 
solid black line going around the entire page, you can safely 
disregard that error.

Recommended Software
Adobe Photoshop Elements – A 30-day free trial of this 
powerful image manipulation software may be found at 
www.adobe.com.

Clipart.com – This site has a large collection of royalty-free 
clip art available for purchase.

Copyrights and Your Yearbook
What is a copyright?
Copyright is a form of protection provided by the laws 
of the United States and other countries to authors of 
“original works of authorship,” including literary, dramatic, 
musical, artistic, and certain other creative works. This 
protection allows the creator exclusive rights to these 
works, and to determine who has the “right to copy” these 
works.

Anderson’s Yearbooks reserves the right to refuse to 
print any material for which you are not the author and 
for which proof of permission to reproduce, or other 
satisfactory evidence of the right to produce such material, 
is not provided. 

How can I find out who owns a copyright?
Some investigative work will be required. If the copyright 
owner is not listed outright on the work you wish to copy, 
you may need to directly contact the publisher of the work 
where you viewed the image to see if they know who the 
copyright owner would be. For Web pages, you may need 
to contact the webmaster of the site or the company that 
produced it. For books it is recommended to contact the 
publisher. Anderson’s Yearbooks cannot provide copyright 
advice for you. It is your responsibility to do necessary due 
diligence and provide us this information. 

In most cases it is easy to obtain permission from 
companies for logos and images by simply contacting 
them. Most professional clip art packages allow 
reproduction rights for the files you purchase. Other 
sources such as Getty Images (www.gettyimages.com), 
Landov (www.landov.com) or other image providers have 
special rates for schools purchasing photos for reproduction 
in yearbooks. You may also search for “Public Domain” 
images, which have limited or no rights restrictions.

You should begin the search immediately if you know 
you have possible copyrighted images. Any delay after 
submission of your yearbook to obtain permission will delay 
your delivery!

What do I need to provide to be able to use a 
copyrighted work?
Anderson’s Yearbooks may require a satisfactory letter of 
verification from the copyright owner which grants you 
permission to use their work in your yearbook. In the case 
of purchased clip art or images, simply include a copy of 
your License Agreement, which should specify your rights 
to reproduce the images in your yearbook. Your yearbook 
may be placed “on hold” until all copyright issues have 
been cleared.

Can I quote poems or music lyrics?
Poems and lyrics may also be protected by copyright. It is 
advisable to get the rights from the author or publisher 
before using it.
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Special Characters Available in STAGES


